
 

 
 

Process automation with 

the SIMATIC PCS 7 

CPU 410-5H controller 

 
SIMATIC PCS 7 V9.0 – CPU 410-5H Firmware V8.2 
 

https://support.industry.siemens.com/cs/ww/en/view/96839331 

  
 

Siemens 

Industry 

Online 

Support 

https://support.industry.siemens.com/cs/ww/en/view/96839331


Legal information 

 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V3.2,    10/2019   2 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG ("Siemens"). They are 
non-binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with Industrial Security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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Preface 

Introduction 

There are various automation systems available for the SIMATIC PCS 7 process 
control system which differ in performance, quantity structure, communications 
interfaces and scalability, among other things. These include:  

• AS 410 automation system (AS 410-5H and AS 410E) 

• Complementary S7-400 systems (AS 412 to AS 417) 

Depending on the automation performance requirements, CPU 412 to CPU 417 may 
be used on the complementary S7-400 systems. If the performance limit of one of the 
CPUs being used is reached, e.g., as a result of necessary modifications to the user 
program, the hardware must be exchanged to increase the performance, or a higher 
performance S7-400 system used. 

AS 410 automation systems are the preferred choice for all new plants with SIMATIC  
PCS 7. For applications with a small quantity structure the CPU 410E is appropriate,  
for all other applications there is the versatile CPU 410-5H. 
The automation performance of the CPU 410-5H is scaled without having to change  
the CPU and is effected by means of the number of SIMATIC PCS 7 process objects.  
In this case the best performance is always available regardless of the area of application.  
The type reduction to a single CPU offers numerous advantages. It considerably simplifies 
the selection, configuration and planning of the automation system as well as spare parts 
inventory and plant expansion. 

Document contents 

In this document, scenarios are described which explain relevant functions of the CPU 
410-5H Process Automation in the AS 410 and illustrate advantages compared to the 
complementary S7-400 systems. Additionally you will gain an overview of important 
configuration steps and hints. The CPU 410E behaves like a CPU 410-5H with limited 
quantity structures, so that the scenarios described in this application example apply 
to the CPU 410-5H as well as to the CPU 410E. 

You will find information on the following topics in the document: 

• General information on the CPUs of the AS 410 

• Advantages of the CPU 410-5H 

• Configuring the communications interface and establishing the connection between 
the ES and the AS  

• Type Change in RUN (TCiR) and Configuration in Run (CiR/H-CiR) 

• Configuration of the PN/Ethernet interfaces 

• Upgrade with CPU 410 Expansion Packs (process objects and PN Red License) 

Validity 

This application example is valid for: 

• CPU 410-5H Process Automation and CPU 410E Firmware version 8.2 

• SIMATIC PCS 7 V9.0 
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1 Overview of AS 410 automation system 
The rugged AS 410 automation system is a modern, future-oriented, all-round system 
for the process industry. It forms the basis for future developments and can be 
deployed in all areas of application with versatility. AS 410 is thus the system of choice 
for all new plants with SIMATIC PCS 7. 
The use of the AS 410 is particularly useful for PCS 7 systems with PROFINET as it is 
the only automation system that supports the following PROFINET functions in 
conjunction with PCS 7 V9.0: 

• Redundant PROFINET R1 configuration 

• Configuration in Run (CiR) 

• High-precision time stamping (SoE – Sequence of Events)) 

 

Two versions of the CPU are available for the AS 410: 

• CPU 410-5H – scalable performance for all applications 

• CPU 410E – fixed quantity structure for applications with few process objects 

An AS 410 with CPU 410-5H or CPU 410E can be configured as a standard high-
availability or safety-oriented automation system, depending on your requirements. 
Technically speaking, the CPU 410E program and system behave like those of a CPU 
410-5H with limited quantity structures. This means that the statements made in this 
application example concerning the CPU 410-5H also apply to the CPU 410E. 

Benefits 

• A hardware platform for all application uses, application sizes and performance 
ranges 

• Specially developed for process automation 

• Conformal coating 

• Extended temperature range (0 °C to +70 °C) 

• PROFINET functions (R1, CiR and SoE) 

• Reduction of plant downtime thanks to the possibility of type updating of AS 
blocks in RUN mode (TCiR) and configuration modifications in Run for 
PROFINET and PROFIBUS (CiR/H-CiR). 

• Integrated remaining load memory 
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1.1 CPU 410-5H – the "all-rounder" for process automation 

In this chapter you will find general information on the CPU 410-5H, its functions 
and areas of application. 

1.1.1 Introduction 

The CPU 410-5H is a controller specially designed for process automation which is 
versatile in use. With its robust, high performance hardware, the CPU 410-5H covers 
the entire performance spectrum of the AS 412 to AS 417 complementary systems. 

Scalable quantity structure 

The quantity structure of the CPU 410-5H can be individually scaled according to 
the size and type of the PCS 7 applications. This is done by means of the PO 
volume, which is determined by the System Expansion Card (SEC). The volume 
extends from 100 PO (process objects) to 2k + PO (unlimited), at which point other 
performance data of the CPU act as the limiting factor. 

The PO quantity structure of an SEC can be conveniently extended from the PCS 7 
V8.1 by means of CPU 410 expansion packs. It is not necessary to uninstall the CPU 
or the SEC. There are CPU 410 expansion packs available for 100 POs and 500 POs. 
You have the following options when ordering CPU 410 expansion packs: 

• Online via http://www.siemens.com/industrymall 

• Through your Siemens contact person (www.siemens.com/automation/partner) 

Communication 

The CPU 410 has two PROFINET/Ethernet interfaces with an integrated 2-port 
switch. As a standard automation system, these enable the simple connection (S1) 
of PROFINET devices and, configured as an H system, the connection of devices 
via system redundancy S2. From FW V8.2, in its expansion as an H system the 
CPU 410 additionally supports the redundant connection (R1). 
Per PROFINET interface a maximum of 250 devices can be connected.  
Consequently, per AS 410 as many as 500 devices can be operated via 
PROFINET. It is not possible to use the CP 443-1 for PROFINET. 

The CPU 410-5H provides a peripheral address range of 8 kB per PROFINET interface. 

In addition, the CPU has a PROFIBUS interface with 12 MBit/s and allows the 
connection of up to 96 PROFIBUS nodes. 

The distributed process periphery can thus either be linked directly with PROFINET, 
PROFIBUS DP or via a subordinate bus system, such as PROFIBUS PA. 

The connection to the plant bus can be made either via the communication module CP 
443-1 or via the PROFINET/Ethernet interfaces integrated in the CPU. If an integrated 
interface is used to connect to the plant bus, it cannot be used for PROFINET. 

http://www.siemens.com/industrymall
www.siemens.com/automation/partner
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Note For further information on the use of PROFINET in SIMATIC PCS 7, please refer 
to the application example: 
“PROFINET in SIMATIC PCS 7 – Guidelines and Blueprints” 
https://support.industry.siemens.com/cs/ww/en/view/72887082 

 

Process safety functions 

The CPU 410 is set up as standard for integrated process safety functions and 
offers all the functions required for safety-oriented applications. The controller is 
TÜV certified and meets all safety requirements up to SIL 3. The CPU is capable of 
multitasking, meaning that several programs can run simultaneously - both Basic 
Process Control Applications (BPCS) and safety-oriented applications. The 
programs are also reaction-free, with the result that potential errors in the BPCS 
applications have no effect on the safety-oriented applications and vice versa. 

The PROFIsafe profile allows safety-related communication between the automation 
system (controller) and the process periphery via either PROFIBUS or PROFINET. 

High availability 

To reduce the risk of production downtime and ensure maximum availability, the 
AS 410 can be configured as a high-availability automation system. A highly 
available automation system AS 410 is constructed from two redundant, electrically 
isolated controllers (CPU 410). These can be mounted on a common rack or also 
operated synchronously at a distance of up to ten kilometers from one another.  
In this case, one of the two CPUs functions as the master and the other as the 
reserve. Synchronization modules can be connected in pairs by means of fiber-
optic cables. The modules can be exchanged during operation. 

  

https://support.industry.siemens.com/cs/ww/en/view/72887082
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1.1.2 Enhanced functions - Firmware V8.2 

The CPU 410’s Firmware V8.2 makes numerous new functions available. Firmware 
V8.2 can be used with all CPU 410-5Hs or CPU 410Es. 

PROFINET extensions 

• Support from PROFINET configurations (R1) as a complement to PROFINET 
system redundancy (S2). 
The CPU 410 Expansion Pack (PN Red) is necessary for the use of this 
configuration. The procedure for transferring the licenses of this expansion 
pack is identical to the procedure for expanding the PO volume of the CPU 
410. See Chapter 2.6. 

• Support from configuration changes in the operation of the CPU in the 
H system (H-CiR) and individual operation (CiR) See section 2.5. 

• Support of the highly precise time stamp – Sequence of Events (SoE). 

Security extensions 

• New protective function for PROFIBUS and PROFINET interfaces  
(Field Interface Security), see Chapter 2.7.1. 

• Support of SysLog in conjunction with SIEM (Security Incident Event Management) 
systems, see Chapter 2.7.2. 

Other extensions 

• The Load memory is maintained independent of a buffering by buffer batteries. 
The CPU can restart itself automatically after power failures even without 
buffer batteries. See Section 2.7.3. 

• The possibility for firmware updates in two working steps for future firmware 
versions. See Section 2.7.4. 

 

Note You can download the firmware updates in the entry: 
“Operating system update: CPU410-5H Process Automation" 
https://support.industry.siemens.com/cs/ww/en/view/109476571 

For instructions on how to perform the update, please see: 
“Instructions for Updating the CPU 410 Operating System” 
https://support.industry.siemens.com/cs/ww/en/view/85196540 

 

  

https://support.industry.siemens.com/cs/ww/en/view/109476571
https://support.industry.siemens.com/cs/ww/en/view/85196540
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1.1.3 Advantages of the CPU 410-5H 

General information 

The CPU 410-5H offers, among others, the following advantages: 

• A hardware platform for all application uses, application sizes and performance 
ranges.  

Consequently the selection, configuration and planning of the automation 
system are simplified. 

• Lower costs for spare or replacement part inventories, as only one CPU type is 
used in the project. 

• Flexible expansion of the automation performance without replacing hardware. 

Plant planning 

The advantages of the CPU 410-5H come into their own above all when planning a 
new plant: 

• When planning the automation performance necessary for your plant, you will no 
longer have to consider different CPU variants, as the CPU 410-5H can be used 
for all purposes (e.g. as an H or an F system, as well as for all application sizes).  

• The required automation performance (PO volumes) can be ordered according 
to the application size after the engineering phase is complete. 

• The automation performance can be conveniently expanded as required at any 
time by means of the CPU System Expansion Card (SEC), without any 
exchange of hardware or plant downtime.  

• The planning of the CPU spares is simplified considerably by the use of 
standardized hardware. In this case you will only need one CPU 410-5H without 
SEC as a replacement part, since the SEC can be transferred if the CPU is 
exchanged. 

• Due to networking with PROFINET (PN), switchgear and drives can be reached 
by every CPU without expensive cabling. Should program relocations to another 
CPU arise in the course of the implementation, it will not be necessary to rewire 
the station or the device. 

 

Note The PN communication which spans the CPUs can influence the performance 
capability of all the CPUs in the PN network. 
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1.2 CPU 410E – for applications with up to 200 process objects 

In this chapter you will find general information on the CPU 410E, its functions and 
areas of application. 

1.2.1 Introduction 

The AS 410 automation system with CPU 410E Process Automation is a cost-saving 
alternative to the use of the CPU 410-5H for small applications. Based on CPU 410-5H 
hardware, the CPU 410E offers the same benefits for applications with up to 200 PO. 

Technically speaking, the CPU 410E program and system behave like those of a CPU 
410-5H with limited quantity structures. This means that the statements made in this 
application example concerning the CPU 410-5H also apply to the CPU 410E. 

1.2.2 Restrictions compared with the CPU 410-5H 

The table below gives an overview of the most important differences between the 
CPU 410-5H and the CPU 410E: 

Table 1-1 

 CPU 410-5H CPU 410E 

PCS 7 process objects (PO) 
100 up to c. 2600 
scalable with SEC 

200 

Work memory (program/data) 32 MB 4 MB 

Periphery address area 
PROFIBUS 6 KB 1536 bytes 

PROFINET 8 KB 1536 bytes 

 

Note You will find further technical data on the CPU 410-5H and the CPU 410E in the 
following manual: 
"SIMATIC PCS 7 Process Control System CPU 410 Process Automation" 
https://support.industry.siemens.com/cs/ww/en/view/109748473 

 

https://support.industry.siemens.com/cs/ww/en/view/109748473
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2 Application scenarios 

2.1 Configuring the communications interface and 
Establishing the connection between the ES and the AS 

In order to implement the application scenarios described in this chapter, a connection 
must be set up between the Engineering Station (ES) and the Automation System.  
The configuration procedure depends on the communications interface used.  
A distinction is made between:  

• AS with additional CP 

• Internal PN/Ethernet interfaces of the CPU 

2.1.1 Establishing a connection using an additional CP in the AS 

The following will describe how to establish a connection between ES and AS using 
the CP 443-1. 

Requirement 

In order to establish a connection between the ES and the AS (via the CP), the 
modules must be fitted in the rack as shown in the operating manual. 

Preliminary considerations 

Before establishing communication, you must define whether you want to use 
TCP/IP or ISO. Addressing (IP address, MAC address) is carried out on the basis 
of the interface selection. 

 

Note Communication in the plant bus is normally based on the ISO protocol. 
Alternatively, TCP/IP can be used, e.g. when using a common (combined) 
terminal and plant bus for smaller systems without an OS server or when using 
the internal Ethernet interface of an automation system. 

You can find additional information on configuring the network connections in the 
manual: 
“SIMATIC Process Control System PCS 7 Compendium Part A - Configuration 
Guidelines” 
https://support.industry.siemens.com/cs/ww/en/view/109740190 

 

 

  

https://support.industry.siemens.com/cs/ww/en/view/109740190


2 Application scenarios 

 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V3.2,    10/2019   12 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Connection via ISO interface 

The following points are a step-by-step description of how to establish the connection 
between the AS and the ES. 

1. Configure the AS in the HW Config. and assign the address for the CP (MAC 
address) accordingly. 

 

 

2. Save and compile the configuration. 

3. In the SIMATIC Manager, use menu command "Tools > Set PG/PC interface..." 
to set the "Interface parameter setting used" to "ISO" (e.g., CP1623.ISO.1). 

4. Switch back to the HW Config. 

5. Execute the menu command "Target system > Load in module...". 
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6. In the "Select Target Module" dialog window, select the relevant module and 
click on "OK". 
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7. If you have not changed the MAC address for the CP (configured MAC address is 
the same as the factory-set MAC address), click on the "OK" button in the  
"Select Node Address" dialog window. 

 

 

 

  

 



2 Application scenarios 

 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V3.2,    10/2019   15 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

If you have configured a different MAC address, then click on the "View" button. 
Then in the "Accessible Nodes" box, select the CP from which you want to load the 
configuration. Then click on the "OK" button. 

 

 

8. The configuration has now been loaded into the AS.  

 

Note After an address change, always load the configuration via the HW Config or 
NetPro. The accessible nodes to which you can make assignments by loading a 
new address are only shown here. When loading from the SIMATIC Manager, an 
attempt will be made to load via the configured address. Since this cannot be 
accessed, the loading procedure will be aborted, accompanied by an appropriate 
message. 
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Connection via TCP/IP interface 

The following points are a step-by-step description of how to establish the connection 
between the AS and the ES. 

1. Configure the AS in the HW Config. and assign the IP parameters for the CP 
(IP address, subnet mask) accordingly. 

 

 

2. Save and compile the configuration. 

3. In the SIMATIC Manager, use menu command "Tools > Set PG/PC station..." 
to set the "Interface parameter setting used" to "RFC1006" or "TCPIP"  
(e.g., CP1623.RFC1006.1). 

4. Switch back to the HW Config. 

5. Execute the menu command "Target system > Edit Ethernet Node". 
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6. Click on the "Browse" button in the "Edit Ethernet Node" dialog window. 
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7. In the "Browse Network" dialog window, select the CP by means of the MAC 
address and click on the "OK" button. 

 

 

Note 

 

If not all or none of the connected nodes are displayed, check the settings for the 
used network components (switches,...). 
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8. The MAC address and the IP parameters for the CP are entered in the "Edit 
Ethernet Node" dialog window. Adapt the IP parameters according to your 
configuration in HW Config (see Step 1). Next click on the "Assign IP  
Configuration" button and then on the "Close" button. 

 

 

Note If you start the search again, you can check to see if the parameters have been 
correctly accepted. 
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9. Execute the menu command "Target system > Load in module...". 

10. In the "Select Target Module" dialog window, select the relevant module and 
click on "OK". 

 

 

11. In the "Enter connection to target station" box in the "Select Node Address" 
dialog window, select the relevant IP address and click on the "OK" button. 

 

The configuration has now been loaded into the AS.  
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2.1.2 Establishing a connection via internal PN/Ethernet interfaces of the CPU 

The following describes how to establish a connection between the ES and the AS 
using the internal PN/Ethernet interfaces of the CPU 410. 

Requirement 

In order to establish a connection between the ES and the AS using the internal 
interfaces of the CPU 410, the CPU 410 must be fitted in the rack as shown in the 
operating manual and be connected to the ES via the network (Ethernet). 

Preliminary considerations 

Before configuring, define which interface is to be used to connect the CPU to the 
plant bus. An IP address from the address range of the plant bus must be used for 
the interface. 

 

Note The ISO protocol is not supported by the internal PN/Ethernet interfaces. 

 

Connection via PN/Ethernet interface 

The following points are a step-by-step description of how to establish the initial 
connection between the CPU 410 and the ES. 

1. Configure the AS in the HW Config. and assign the IP parameters (IP address, 
subnet mask) on the PN/Ethernet interface. 
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2. Save and compile the configuration. 

3. In the SIMATIC Manager, use menu command "Tools > Set PG/PC interface... 
" to set the "Interface parameter setting used" to "RFC1006" or "TCPIP"  
(e.g., CP1623.RFC1006.1). 

4. Switch to the HW Config. 

5. Execute the menu command "Target system > Edit Ethernet Node". 

6. Click on the "Browse" button in the "Edit Ethernet Node" dialog window. 
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7. In the "Browse Network" dialog window, select the CPU by means of the MAC 
address and click on the "OK" button. 

 

 

Note If not all or none of the connected nodes are displayed, check the settings for the 
used network components (switches,...). 
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8. The MAC address and the IP parameters for the Ethernet interface are entered 
in the "Edit Ethernet Node" dialog window. Adapt the IP parameters according 
to your configuration in HW Config (see Step 1). Next click on the "Assign IP 
Configuration" button and then on the "Close" button. 

 

 

Note If you start the search again, you can check to see if the parameters have been 
correctly accepted. 
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9. Execute the menu command "Target system > Load in module...". 

10. In the "Select Target Module" dialog window, select the relevant module and 
click on "OK". 

 

 

11. In the "Enter connection to target station" box in the "Select Node Address" 
dialog window, select the relevant IP address and click on the "OK" button. 

 

The configuration has now been loaded into the AS. 
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2.2 Loading interface changes from AS blocks in RUN mode 
(TCiR) 

Introduction 

From firmware V8.1 and in conjunction with SIMATIC PCS V8.1 or higher, the CPU 
410 supports type updating with interface changes in RUN mode (Type Change in 
RUN (TCiR)). It is thus possible to update the instances after an interface change 
to block types and load them into the target system in RUN mode. With the TCiR 
function you can, for example, also update a library without having to put the CPU 
in the STOP state (see Chapter 2.3). 
 

NOTICE Note that you must create new blocks (new number) for the instances of 
the changed block types that were loaded into the CPU by means of TCiR. 
The system deactivates the blocks in WinCC until the OS server has be 
been re-compiled and loaded. 

In the case of a redundant OS server, you can do this before loading AS 
TCiR and loading one of the servers. This means that the plant can be 
operated before and after AS TCiR loading. 

Note, however, that when doing this data can be lost in the area of 
archiving. 

 

NOTICE The following changes to the block can only be loaded in STOP mode: 

• Changed name of an input with configured message  
("Message Event ID") 

 

Note You can find a detailed description of TCiR in the CFC online help system and in 
the “SIMATIC Process Control System PCS 7 CFC for SIMATIC S7 (V9.0)” 
function manual. 
https://support.industry.siemens.com/cs/ww/en/view/109748700 

 

This chapter will describe as an example how to add a new connection to the block 
and then load this change into the CPU 410 in RUN mode.  

Requirements 

The following requirements apply: 

• A PCS 7 multiproject is open in the SIMATIC Manager. 

• The automation program has been compiled and loaded into the CPU 410. 

• Loading of the automation program was carried out with a CFC of Version V8.1 
(or above) 

• The firmware status of the CPU 410 is V8.1 (or above) 

• There is enough storage space on the CPU for modified blocks 

• There are enough reserve POs on the CPU 

https://support.industry.siemens.com/cs/ww/en/view/109748700


2 Application scenarios 

 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V3.2,    10/2019   27 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Making interface changes  

Open the master data library for the project in component view. 

1. Open the "Sources" folder. 

2. Open the SCL source for the desired block type. 

 

 

3. Carry out the desired changes. 
In this example, the connection "LOCK_2" will be added for an additional 
interlock on the block. 

 

 

4. Save the changes and compile the SCL program. 

5. Close the SCL source. 
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Loading interface changes in RUN mode  

1. Select the "Blocks" folder in the master data library. 

2. Carry out command "Extras > Charts > Update block types". 
The "Update block types" dialog opens. 

3. Select the check box in the "Download in RUN" column and click on the 
"Calculate" button in the "Resources" column. 

 

The "Resource information" dialog opens. This contains information about resource 
requirements for type changing in the automation system in which the type change 
is carried out. 
 

 
 

 

  

Note If not enough resources are available, loading is only possible via STOP. 
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4. Close the "Resource information" dialog. 

5. In the "Update block types” dialog, click on the “Next” button. 
In this step, the display shows whether the type change can be carried out in 
the RUN state on the basis of the calculation in the "Consequence" field.  

 

6. Click on the "Finish” button. Wait until the updating procedure has been 
completed successfully. A log file is displayed at the end of the procedure. 

7. Select the "Charts" folder for the AS program and open a CFC chart. 

The message "TCiR: Loading successful!” is displayed. 
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8. Click on the "Load" button on the toolbar. 
The "Compile program/Download to target system" dialog opens. 

9. Select the "Entire program" option on the "Compile charts as program" tab. 

 

 

10. Open the "S7 download" tab and select the "Changes only" option. 

 
 

11. Click on the “OK” button. 
The interface changes are downloaded into the CPU 410 in RUN mode. 
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2.3 Using TCiR to update a library 

Requirements 

When updating an entire library, the same conditions and rules apply as to updating of 
an individual block. 
 

Note In general, upgrading using TCIR should have the aim of not stopping the AS but 
not demand migration of the project (the plant) to Run Time. 

 

NOTICE Note that you must create new blocks (new number) for the instances of 
the changed block types that were loaded into the CPU by means of TCiR. 
The system deactivates the blocks in WinCC until the OS server has be 
been re-compiled and loaded. 

In the case of a redundant OS server, you can do this before loading AS 
TCiR and loading one of the servers. This means that the plant can be 
operated before and after AS TCiR loading. 

Note, however, that when doing this data can be lost in the area of 
archiving. 

 

Note You can find a detailed description of TCiR in the CFC online help system and in 
the “SIMATIC Process Control System PCS 7 CFC for SIMATIC S7 (V9.0)” 
function manual. 
https://support.industry.siemens.com/cs/ww/en/view/109748700 

 

The procedure for updating a library is described in the “Information and brief 
instructions for updating/upgrading PCS 7 software” manuals 
(https://support.industry.siemens.com/cs/ww/en/view/39980937). 

License check 

Note that at updating, more AS RT POs may be needed temporarily. This is the 
case if counting of AS RT PO is carried out in the CPU by the assigned memory. 

To ensure that enough POs are available, proceed as described below. 

1. Right-click the multiproject. 

2. Select the “PCS 7 license information” menu item. 

3. Make a note of the number of configured and booked POs and the maximum 
number of POs. 

4. Check whether the AS RT counts the POs according to the assigned memory. 
 

Note You will find detailed information on the PO count in the following FAQs: 
“How are the licenses for the AS and OS counted in PCS 7 V7.0 onwards?” 
https://support.industry.siemens.com/cs/ww/en/view/38855207 

 

  

https://support.industry.siemens.com/cs/ww/en/view/109748700
https://support.industry.siemens.com/cs/ww/en/view/39980937
https://support.industry.siemens.com/cs/ww/en/view/38855207
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If AS RT POs are not counted according to the assigned memory or if adequate spare 
POs are available, continue with “Resource Checking” in this chapter.  

If the AS RT counts the POs according to the assigned memory, load the program 
via STOP. 

NOTICE If not enough AS RT POs are available on the CPU, downloading is not 
carried out. It is then only possible to update the user program by overall 
loading in STOP mode. 

 

Resource checking 

After updating the blocks in the master data library, proceed as described below. 

1. Select the "Blocks" folder in the master data library. 

Carry out command "Extras > Charts > Update block types". 
The "Update block types" dialog opens. 

2. Select the check box in the "Download in RUN" column and click on the 
"Calculate" button in the "Resources" column. 

 

The "Resource information" dialog opens. This contains information about resource 
requirements for type changing in the automation system in which the type change 
is made. 
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3. Check whether the there are adequate resources: 
If there are, proceed as described in chapter 2.2 from step 4 onward.  
 

Note If not enough resources are available, loading is only possible via STOP. 

 

2.4 Configuring the PN/Ethernet interfaces of the CPU 410 

In this chapter you will find information about configuration options for the PN/Ethernet 
interfaces of the CPU 410. The configurations are explained using the example of the 
CPU 410-5H and can be applied in the same way for the CPU 410E. 

2.4.1 Standard Automation System – Configuring the interfaces for connection 
to the plant bus and the field bus without using an external CP 

Due to its two PN/Ethernet interfaces, the CPU 410 can provide the option of 
implementing a connection to the plant bus and the field bus without using an external 
CP. This yields the following benefits: 

• Reduction of hardware costs 

• More space due to the use of compact mounting racks 

The configuration procedure is carried out in the following steps: 

• Adding a new AS station to the project 

• Configure the interface for the plant bus 

• Configure the interface for the field bus 
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The following figure shows the configuration schematically: 
 

Fig. 2-1 

CPU 410-5H

ET 200SP HA

Terminal / Plant Bus

Engineering Station

Operation Station

XR-300

ET 200M

XF204-2BA

Industrial Ethernet

SIMOCODE

SINAMICS

XC-200

CFU

PROFINET

 

 

Requirements 

The following requirements must be met: 

• There is a PCS 7 multiproject present. 

• A CPU 410-5H is connected. 

Adding a new AS station to the project 

1. Open a PCS 7 multiproject in the SIMATIC Manager. 

2. Insert a new sub-project using the "File > New project" command. 

3. Right-click on the sub-project and choose the "Insert new object > 
Preconfigured station“ command from the context menu. 
The "PCS 7 Wizard: Expand project" dialog opens. 

4. Select the CPU 410-5H without CP and insert the station. In this example, the 
procedure is explained using the example of a single station (AS410-Single (1H)). 

5. Open the AS station with the CPU 410-5H in HW Config. 
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Configuring the interface for the plant bus 

1. Open the properties for the "PN-IO-X5" interface of the CPU 410-5H in the HW 
Config. 

 

 

2. Enter an unequivocal device name in the "General" tab. 

3. Click on the "Properties..." button 
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4. Enter a valid IP address and subnet mask for the plant bus. 

 

 

5. Assign an existing subnet to the interface or create a new subnet for it. In this 
example, a new subnet is created for the plant bus and assigned to the interface.  

 

6. Confirm your settings with "OK". 
The interface is connected to the plant bus. 
From PCS V9.0 a PROFINET IO system is also created for connecting the 
PROFINET IO modules. This is not needed and can optionally be deleted 
using the short cut menu 
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Configuring the interface for the field bus 

1. Open the properties for the "PN-IO-X8" interface of the CPU 410-5H in the HW 
Config. 

 

2. Enter an unequivocal device name in the "General" tab. 

3. Click on the "Properties..." button 

 

4. Enter a valid IP address and subnet mask for the field bus. 
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5. Assign an existing subnet to the interface or create a new subnet for it. In this 
example, a new subnet is created for the field bus and assigned to the interface. 

 

6. Confirm your settings with "OK". 
From PCS 7 V9.0 a PROFINET IO system is also created for connecting the 
PROFINET IO devices. With PCS 7 Version V8.2 and lower, right-click to 
select the interface and select the "Insert PROFINET IO system" command 
from the context menu. 

Result 

The interface X5 of the CPU is configured for connection to the plant bus and the 
interface X8 for the connection of PROFINET devices 

 

Note For further information on PROFINET in SIMATIC PCS 7, e.g. recommended 
PROFINET network configurations, see the application example: 
“PROFINET in SIMATIC PCS 7 – Guidelines and Blueprints” 
https://support.industry.siemens.com/cs/ww/en/view/72887082 

https://support.industry.siemens.com/cs/ww/en/view/72887082
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2.4.2 Standard Automation System – Configuring two separate PROFINET 
interfaces for connection to the field bus 

When there is a large number of devices, the CPU 410 offers the option of 
configuring two PROFINET interfaces for connection to the field bus. In this case, 
the connection to the plant bus is made via an external CP. 

The configuration procedure is carried out in the following steps: 

• Adding a new AS station to the project 

• Configure the interface for the plant bus 

• Configuring two PROFINET interfaces for the field bus 

The following figure shows the configuration schematically: 
 

Fig. 2-2 

CPU 410-5H

ET 200SP HA

Terminal / Plant Bus

Engineering Station

Operation Station

XR-300

ET 200M

XF204-2BA

Industrial Ethernet

SIMOCODE

SINAMICS

XC-200

CFU

PROFINET

 

Requirements  

The following requirements must be met: 

• There is a PCS 7 multiproject present. 

• A CPU 410-5H is connected. 
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Adding a new AS station to the project 

Proceed as follows to configure two PROFINET interfaces for the field bus: 

1. Open a PCS 7 multiproject in the SIMATIC Manager. 

2. Insert a new sub-project using the "File > New project" command. 

3. Right-click on the sub-project and choose the "Insert new object > 
Preconfigured station“ command from the context menu. 
The "PCS 7 Wizard: Expand project" dialog opens. 

4. Select the CPU 410-5H with a CP and insert the station. In this example, the 
procedure is explained using the example of a single station (AS410-Single (1H)) 
with a CP 443-1. 

Configure the interface for the plant bus 

1. Open the AS station with the CPU 410-5H in the HW Config. 

2. Open the properties for the "PN-IO" interface of the CP 443-1. 
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3. Open the "General" tab and enter an unequivocal device name. 

4. Click on the "Properties..." button. 

 

5. Activate the check box "Set MAC address/use ISO protocol" and assign the 
MAC addresses you wish. 
Enter a valid IP address and subnet mask for the plant bus or deactivate the 
option box “use IP protocol”. 

6. Assign an existing subnet to the interface or create a new subnet for it. 

 

7. Confirm your settings with "OK". 
The interface of the CP443-1 is connected to the plant bus. 
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Configuring the PROFINET interfaces for the field bus 

When configuring interfaces X5 and X8, it must be borne in mind that the IP 
addresses of interfaces X5 and X8 must be located in different IP address areas. 

1. Open the properties of the "PN-IO-X5" interface and enter an unequivocal 
device name in the "General" tab. 

2. Click on the "Properties..." button. 

 

3. Enter a valid IP address and subnet mask. 

4. Assign an existing subnet to the interface or create a new subnet for it. In this 
example, a new subnet is created for the field bus and assigned to the interface. 
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5. Confirm your settings with "OK". 
From PCS 7 V9.0, a PROFINET IO system for connecting the PROFINET IO 
modules is created automatically. If a PCS 7 in version V8.2 and lower is being 
used, select the interface with the right mouse button and select the  
"Insert PROFINET IO system" command in the context menu. 

 

 

6. Repeat steps 1-5 for "PN-IO-X8" interface. 
In this example, the device name "AS02-PN-IO-X8", the IP address 
"192.168.3.1" (IP address range different from that of interface X5) and the 
new subnet "Fieldbus2" are used. 
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Result 

The CP 443-1 is used for connecting to the plant bus. The internal interfaces of the 
CPU X5 and X8 are both configured for the connection of PROFINET devices. 

 

 

 

Note For further information on PROFINET in SIMATIC PCS 7, e.g. recommended 
PROFINET network configurations, see the application example: 
“PROFINET in SIMATIC PCS 7 – Guidelines and Blueprints” 
https://support.industry.siemens.com/cs/ww/en/view/72887082 

 

  

https://support.industry.siemens.com/cs/ww/en/view/72887082
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2.4.3 High-availability automation system – Configuration of the interfaces 

Highly available automation systems based on the CPU 410 enable the connection of 
PROFINET devices via simple S2 system redundancy as well as the configuration of 
redundant PROFINET configurations (R1).  

For the segmentation of networks or when there is a large number of devices, the 
CPU 410 offers the option of configuring both PROFINET interfaces for connection to 
the field bus. In the following configuration the interface X5 is used for the connection 
of devices via simple system redundancy S2 and the interface X8 for the configuration 
of a redundant PROFINET configuration (R1). In the redundant PROFINET 
configuration (R1), the devices have two interface modules and are thus connected to 
the high-availability automation system via two separate PROFINET networks. 

In this case, the connection to the plant bus is made via external CPs. Alternatively, 
the connection to the plant bus can also take place via the PROFINET/Ethernet 
interfaces integrated in the CPU. If internal interfaces are used to connect to the 
plant bus, these cannot be used for PROFINET. 

The configuration procedure is carried out in the following steps: 

• Adding a new AS station to the project 

• Configuring the interface of the CPs for the plant bus 

• Configuring the PROFINET interfaces for the field bus 

The following figure shows the configuration schematically: 

Fig. 2-3 

Terminal / Plant Bus

Engineering Station
Operation Station

XR-300

Industrial Ethernet

ET 200SP HA

CPU 410-5H, red.

PROFINET – electrical,  redundant

ET 200M

CFU

ET 200SP HA
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Adding a new AS station to the project 

Proceed as follows to configure two PROFINET interfaces for the field bus: 

1. Open a PCS 7 multiproject in the SIMATIC Manager. 

2. Insert a new sub-project using the "File > New project" command. 

3. Right-click on the sub-project and choose the "Insert new object > 
Preconfigured station“ command from the context menu. 
The "PCS 7 Wizard: Expand project" dialog opens. 

4. Select the CPU 410-5H with a CP and insert the station. In this example, the 
procedure is explained using the example of a redundancy station (AS410-2H) 
with a CP 443-1. 

 

Configuring the interface of the CPs for the plant bus 

1. Open the AS station with the CPU 410-5H in the HW Config. 

2. Open the properties for the "PN-IO" interface of the CP 443-1 ion Rack 0. 
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3. Open the "General" tab and enter an unequivocal device name. 

4. Click on the "Properties..." button. 

 

5. Activate the check box "Set MAC address/use ISO protocol" and assign the 
MAC addresses you wish. 
Enter a valid IP address and subnet mask for the plant bus or deactivate the 
option box “use IP protocol”. 

6. Assign an existing subnet to the interface or create a new subnet for it. 

 

7. Confirm your settings with "OK". 
The interface of the CP443-1 is connected to the plant bus. 

8. Repeat steps 1-7 for CP443-1 in Rack 1. 
In this example, the device name "AS03-R1", the IP address "192.168.1.4"  
(the same IP address range as the CP443-1 in rack 0) and the existing subnet 
“Plant bus" are used. 
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Configuring the PROFINET interfaces for the field bus 

In the following, the interface X5 is configured for the connection of devices via 
simple system redundancy S2 and the interface X8 is used to create a redundant 
PROFINET configuration (R1). No provision has been made for the incorporation of 
S2 devices into the redundant R1 network. 

For the connection of devices via simple system redundancy S2, IP addresses in the 
same IP address area must be used for the corresponding interfaces of the CPU. 

When configuring the interfaces of R1 networks, the following must be borne in 
mind in respect of the IP addresses: 

• In a purely R1 configuration without a Y switch and without embedded S2 devices, 
the two subnets can be in the same IP address ranges or in different ones. 

• In a mixed configuration (R1 and S2 devices), the two subnets must be in the 
same IP address range. 

• When using high-precision time stamps (SoE), the subnets must use different 
IP address ranges. 

 

1. Open the properties of the "PN-IO-X5" interface in Rack 0 and enter an  
unequivocal device name in the "General" tab. 

2. Click on the "Properties..." button. 

 

3. Enter a valid IP address and subnet mask. 

4. Assign an existing subnet to the interface or create a new subnet for it. In this 
example, a new subnet is created for the field bus and assigned to the interface. 
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5. Confirm your settings with "OK". 
From PCS 7 V9.0 a PROFINET IO system is also created for connecting the 
PROFINET IO devices. If a PCS 7 in version V8.2 and lower is being used, 
select the interface with the right mouse button and select the "Insert 
PROFINET IO system" command in the context menu. 
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6. Repeat steps 1-5 for configuring the interfaces "PN-IO-X5" in Rack 1, "PN-IO-
X8" in rack 0 and "PN-IO-X8" in Rack 1, with the data from the following Table. 

 Rack 0: X5 Rack 1: X5 Rack 0: X8 Rack 1: X8 

Device name AS03-R0-PN-
IO-X5 

AS03-R1-PN-
IO-X5 

AS03-R0-PN-
IO-X8 

AS03-R1-PN-
IO-X8 

IP address 192.168.0.1 192.168.0.2 192.168.3.1 192.168.4.1 

Subnet mask 255.255.255.0 255.255.255.0 255.255.255.0 255.255.255.0 

Subnet Fieldbus_1 Fieldbus_1 Fieldbus_R1_1 Fieldbus_R1_2 

 Joint subnet Different subnets 

Result 

Both CP 443-1 units are configured for connection to the plant bus. The internal 
interfaces of the CPU are configured for the connection of PROFINET devices in 
the following manner: 

– X5: Joint subnet for the connection of S2 devices 

– X8: Separate subnet for the connection of R1 devices 

 

Note For further information on PROFINET in SIMATIC PCS 7, e.g. recommended 
PROFINET network configurations, see the application example: 
“PROFINET in SIMATIC PCS 7 – Guidelines and Blueprints” 
https://support.industry.siemens.com/cs/ww/en/view/72887082 

https://support.industry.siemens.com/cs/ww/en/view/72887082
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2.5 Configuration modifications in operation – CiR/H-CiR 

Configuration in Run (CiR) is a function that enables the system and configuration 
(e.g. the addition or modification of hardware) to be changed during operation 
without causing a plant standstill. This function is available to varying degrees for 
both standard automation systems and H-systems. 

Configuration in Run in a standard automation system (CiR) 

When CiR is used in a standard automation system, the process execution of the 
loading process is paused for a brief time interval (CiR synchronization time).  
The process inputs and outputs retain their last value during this time. When using 
the CPU 410-5H, the maximum CiR synchronization time is 60 ms. 

Configuration in Run in a high-availability automation system (H-CiR) 

Besides the modifications that are possible in a standard automation system, it is also 
possible to modify some CPU parameters in a high-availability automation system. 

Sequence of an H-CiR process: 

• Modify the hardware configuration offline 

• When loading: 

– Stop standby CPU 

– Upload new hardware configuration to the standby CPU. 

– Switch over to the CPU with modified configuration 

– Update the second CPU 

• The system works redundantly again 

 

The changes that are possible as a CiR/H-CiR operation depend on whether the 
(changed) IO device has CiR functionality.  

The following table gives an overview: 

Table 2-1 

CiR/H-CiR operation Device without 
CiR 

Device with CiR 

Add IO device ✓ ✓ 

Remove IO device ✓ ✓ 

Add submodule  ✓ 

Remove submodule  ✓ 

Reassign submodule parameters  ✓ 

Interface configuration 

(e.g. enable/disable ports, topology 
configuration) 

 ✓ 

 

Note Additional information on Configuration in Run is available in the following 
documents: 
“PROFINET in SIMATIC PCS 7 – Guidelines and Blueprints” 
https://support.industry.siemens.com/cs/ww/en/view/72887082 
"SIMATIC PCS 7 Process Control System CPU 410 Process Automation" 
https://support.industry.siemens.com/cs/ww/en/view/109748473 

 

https://support.industry.siemens.com/cs/ww/en/view/72887082
https://support.industry.siemens.com/cs/ww/en/view/109748473
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2.5.1 Change parameter assignment of a submodule 

Scenario 

In the PROFINET network of an AS 410 there is a distributed SIMATIC ET 200SP 
HA periphery with the configurable periphery module "AI-DI 16 / DQ 16x24VDC 
HART HA". The plan is in operation and channel 0, which has previously been 
used as a digital input, is to be made available as an analog input (0..24 mA HART) 
in the future. The procedure for changing parameterization and loading during 
operation is described below.  

The following figure shows the configuration schematically: 

Fig. 2-4 

CPU 410-5H

ET 200SP HA

PROFINET

Terminal / Plant Bus

Engineering Station

Operation Station

XR-300

Industrial Ethernet

 

Procedure 

Changing the parameterization is done as described in the following steps: 

• Archiving the CiR load-capable project 

• Changing parameterization 

• Checking CiR capability 

• Loading the hardware configuration during operation 

 

Requirements 

• The PCS 7 multiproject is open in SIMATIC Manager. 

• The hardware configuration and the automation program have been compiled 
and loaded into the CPU 410. 

• The firmware status of the CPU 410 is V8.2 (or above) 

• The CPU 410 is in Run mode. 

• The device whose submodule is to be re-parameterized, must be CiR-capable. 
ET 200SP HA supports CiR. 
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Changing parameter assignment of a periphery module 

1. Archive the project before making any changes. This way, you may still be able 
to reject the changes, should CiR capability be lost. 

2. Double-clicking on the periphery module to open  
"AI-DI16/DQ16 HART HA" the object properties. 
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3. Switch to the "Parameters" tab and in the tree, open "channel 0 > AI". 
Until now, Channel 0 has been parameterized as a Digital Input, i.e. the Analog 
Input (AI) is deactivated. 

 

4. In the "Measurement type" drop-down list, select “Current (2wire)” and confirm 
the settings with OK. 
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Checking CiR capability 

1. Select the menu command “Station > Check CiR capability” to check whether it 
is possible to load modifications during operation. 

 

2. The CiR capability test returns the result that the station is consistent, i.e. the 
changes can be loaded during operation. 
Confirm the dialog with “Close". 
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Loading the hardware configuration during operation 

1. Save and compile your configuration, and then click on “load to module”. 

 

2. Select the “Load station configuration in operating mode RUN” and confirm 
with the “OK” button. 

 

Result 

Channel 0, which has previously been used as a digital input, is now available as 
an analog input (0..24 mA HART). 
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2.5.2 Adding a device 

Scenario 

As part of a function expansion, the periphery of a system is expanded by a 
Compact Field Unit (CFU). Since the process must not be interrupted, the CFU is 
to be integrated into the PROFINET network of the AS 410 during operation. 
The following figure shows the configuration schematically: 

Fig. 2-5 

CPU 410-5H

ET 200SP HA

PROFINET

Terminal / Plant Bus

Engineering Station

Operation Station

XR-300

Industrial Ethernet

CFU

 

The connection of the CFU should be linear to the free port 2 of the ET 200SP HA. 
According to the recommendations for PCS 7, the topology is configured for the 
use of the device replacement function without removable media and unused ports 
are deactivated for security reasons This means that port 2 of the ET 200SP HA 
must be activated for the integration of the CFU and the topology configuration 
must be adapted. 

Procedure 

Adding a device during operation is carried out in the following steps: 

• Archiving the CiR load-capable project 

• Adding a device in the HW Config 

• Adjusting the topology configuration and interface parameterization 

• Checking CiR capability 

• Loading the hardware configuration during operation 

• Connection of the CFU (real plant) 
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Requirements 

• The PCS 7 multiproject is open in SIMATIC Manager. 

• The hardware configuration and the automation program have been compiled 
and loaded into the CPU 410. 

• The firmware status of the CPU 410 is V8.2 (or above) 

• The CPU 410 is in Run mode. 

• All neighboring devices of the new device must support CiR (necessary for the 
adaptation of the topology configuration and the interface parameterization) 

Adding a device 

1. Archive the project before making any changes. This way, you may still be able 
to reject the changes, should CiR capability be lost. 

2. Drag&drop the Compact Field Unit from the module catalog to the PROFINET 
IO system 

 

3. Open the “Object Properties...” via the context menu of the CFU and adapt the 
device name and the IP address according to the plant planning. 
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Activating Port 2 of the ET 200SP HA 

For security reasons it is recommended that ports which are not needed be 
deactivated. In order to use them later, they have to be re-activated. This is only 
possible with CiR-capable devices. ET 200SP HA supports CiR. 

1. Select the ET 200SP HA and open the properties of the port by double-clicking 
ON the port "X1 P2 R". 

 

2. Switch to the "Options" tab and activate the port by selecting "Automatic 
settings" in the "Transfer media/duplex" drop-down list. 

3. Confirm the properties by clicking on the “OK” button. 
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Deactivating the unrequired CFU port 

For security reasons it is recommended that ports which are not required be deactivated. 

1. Select the CFU and open the properties of the port by double-clicking on the port 
"X5 P2 R". 

 

2. Change to the "Options" tab and deactivate the port by selecting “Disable" in 
the "Transfer media/duplex" drop-down list. 

3. Confirm the properties by clicking on the “OK” button. 

 

 

  



2 Application scenarios 

 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V3.2,    10/2019   61 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Adjusting the topology planning 

Topology planning is a precondition for the device replacement function without 
removable media or automatic commissioning. If the function is active, the CPU 
can automatically assign to new, as yet unnamed devices, the name configured in 
HW Config. 

1. Right-click on the PROFINET IO system and select the "PROFINET IO 
Topology..." command from the shortcut menu. 

2. Switch to the "Graphic view" tab. 
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3. Drag&drop Port 2 of the ET 200SP HA to connect with Port 1 of the CFU. 

4. Confirm the dialog “Interconnection properties” with the "OK" button to 
establish a connection. 

 

5. Confirm the adaptations in the topology editor by clicking on the “OK” button. 
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Checking CiR capability 

1. Select the menu command “Station > Check CiR capability” to check whether it 
is possible to load modifications during operation. 

 

2. The CiR capability test returns the result that the station is consistent, i.e. the 
changes can be loaded during operation. 
Confirm the dialog with “Close". 

 

 

 

 

 



2 Application scenarios 

 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V3.2,    10/2019   64 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Loading the hardware configuration during operation 

1. Save and compile your configuration, and then click on “load to module”. 

 

2. Select the “Load station configuration in operating mode RUN” and confirm 
with the “OK” button. 

 

Connection of the CFU (real plant) 

Thanks to the topology configuration, the automatic commissioning for the CFU can 
be made use of. As a prerequisite for automatic commissioning, the CFU used must 
be reset to factory settings and the actual topology (physical connection) must match 
the target topology (topology editor). If these requirements are met, the CFU is 
automatically addressed as soon as the hardware configuration has been loaded. 

Connect Port 2 of the ET 200SP HA with Port 1 of the CFU. 

Result 

The Compact Field Unit has been integrated in the PROFINET network during 
operation and is now available as a periphery. 
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2.6 Upgrade with CPU 410 Expansion Packs 

2.6.1 Introduction 

There are two kinds of CPU 410 Expansion Packs: 

• CPU 410 Expansion Pack (PO) 
Upgrade of the process objects of a CPU 410-5H 

• CPU 410 Expansion Pack (PN Red) 
Activation of the function expansion for the 
support of redundant PROFINET subsystems (R1) 

Enabling functional expansion to support redundant PROFINET subsystems (R1) 

The "PCS 7 CPU 410 EXPANSION PACK (PN RED)” is required for the 
connection of PROFINET devices via redundant PROFINET R1 configurations. 
This is available in two variants: 

• License on USB stick: 6ES7653-2CX01-0XE0 

• License via Online software delivery (download): 6ES7653-2CX01-0XK0 

A firmware version 8.2 or higher is a pre-requisite to be able to load CPU 410 
Expansion Pack PN Red. 

Online upgrade of CPU 410-5H process objects 

When you load a PCS 7 project into the CPU, the system checks that the project 
can run with the current number of process objects (POs) in the CPU.  

If the number is not sufficient, starting with PCS 7 V8.1 you have the option of 
increasing the PO volume by means of an online upgrade of the CPU 410-5H 
system expansion card (SEC). 

CPU 410 Expansion Pack (PO) 

You will need at least one CPU 410 expansion pack for the online upgrade of the 
process objects of a CPU 410-5H.  

The CPU expansion packs for PO are available in the following sizes: 

• 100 PO 

• 500 PO 

The expansion packs can be combined in any way up to the maximum size. Note, 
however, that with a redundant system (2 CPUs), the CPU 410 expansion packs 
must be distributed symmetrically between the CPUs. 

The volume of a CPU expansion pack must always be assigned in its entirety to a 
CPU or SEC of the CPU. Distribution between several CPUs or SECs is not 
possible.  

After a PO upgrade, the POs that are assigned to an SEC/CPU can no longer be 
relocated. 
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Example of a process object upgrade 

If the number of POs in the CPU is not sufficient to load the engineering project, 
you can increase the PO volume of the CPU by means of an online upgrade. 

Table 2-2 

Expanding by 300 PO (from 400 PO to 700 PO) 

 

With a single AS, to increase the number of POs by 
300 you need 3 CPU 410 expansion packs with 100 
POs each. 

 

With a redundant AS (2 CPUs), to increase the 
number of POs by 300 you need 6 CPU 410 
expansion packs, with 100 POs each. This is 
necessary, since both CPUs must be expanded by 
300 POs. 

In this case, you cannot combine expansion packs 
with 500 POs and 100 POs, since the PO volume of 
an expansion pack cannot be subdivided.   
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The table below contains further examples:  

Table 2-3 

PO expansion  
by  

 

CPU 410 expansion packs needed 

 

Single AS Redundant AS 

400 POs  4 x 100 POs 8 x 100 POs 

500 PO 1 x 500 POs or 

5 x 100 POs 

2 x 500 POs or 

10 x 100 POs 

600 POs 1 x 500 POs + 1 x 100 POs or 

6 x 100 POs 

2 x 500 POs + 2 x 100 POs or 

12 x 100 POs 

1000 POs 2 x 500 POs or 

10 x 100 POs 

4 x 500 POs or  

20 x 100 POs 

 

Unlimited PO volume 

The PO volume can be increased to “Unlimited”, i.e. to an unlimited volume of POs. 
Thereafter as many POs can be loaded as the physical storage will admit and until it is 
completely used up. There are two ways to increase the PO volume to “Unlimited”: 

 

• New purchase of CPU410-5H in bundle with PO 2K+. 
(Article number 6ES7654-5CQ00-0XF0) 
 

• With the CPU Expansion Packs 100 and 500, the existing number of POs is 
extended to a total of 2600 POs. 2600 POs on a SEC of a CPU410-5H 
corresponds to an "Unlimited" PO volume.  
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2.6.2 Overview of work steps  

The online upgrade for PO and PN Red is carried out in the following main steps 
(using the increase of 300 POs as an example): 

Table 2-4 

Schematic representation Step 

 

1. Order the CPU 410 expansion packs. 

 

 

2. In the SIMATIC Automation License Manager 
(ALM), transfer the CPU 410 expansion packs to 
the CPU and create a PO activation file. 

 

3. Send the PO activation file for checking and 
activation by means of a support request. 
 
Within 48 hours, you will receive by e-mail a PO 
release file (for each PO activation file sent) as 
confirmation of checking.  

 

4. Transfer the PO release file to the SEC of the 
CPU using the ALM. 

 

Note In a redundant AS only the CPU in Rack 0 is selected. The POs/PN Red license 
is automatically given to both CPUs. 
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NOTICE When performing an online upgrade of the process objects, observe the 
information and notes in the manual: 
“SIMATIC PCS 7 Service Support and Diagnostics (V9.0)” 
https://support.industry.siemens.com/cs/ww/en/view/109746550 

 

2.6.3 Order the CPU 410 expansion packs 

You have the following options when ordering CPU 410 expansion packs (PO and 
PN Red): 

• Through your Siemens contact person (www.siemens.com/automation/partner) 

• Online via www.siemens.com/industrymall 

Fig. 2-6 

 

After you have received the CPU 410 expansion packs (by e-mail or USB stick), 
transfer them to a disk drive that can be accessed by the Engineering Station. 

  

https://support.industry.siemens.com/cs/ww/en/view/109746550
http://www.siemens.com/automation/partner
http://www.siemens.com/industrymall
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2.6.4 Creating the activation file using the Automation License Manager 
(ALM) 

Requirements 

The CPU 410 must be accessible from the Engineering Station. A PCS 7 project 
(HW Config and program) must be loaded. Modifications in the project (e.g. name 
of CPU) are not allowed from creating the activation file until transferring the 
release file, since e.g. project name, name of the automation system and CPU are 
compared while transferring the release file. 
Creating the activation file and transferring the release file must be carried out by 
the same user from the same ES, since the upgrade directory is only created for 
this user. 

Procedure 

1. Store the CPU 410 expansion packs on a drive that can be accessed in the 
Automation License Manager (ALM). 

 

2. Select menu command "Edit > Connect target system > Connect/disconnect 
AS 410...". 

 

 

The "Connect Target System" dialog opens. 
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3. Click on the "Add" button to establish an on-line connection to a CPU 410-5H. 

 

 

4. In the PCS 7 project, select the CPU to which you want to transfer the CPU 
410 expansion packs. Then click on the "OK" button. 

 

The CPU is displayed in the ALM. 

 

5. Drag the license keys for the CPU 410 expansion packs and drop them on to 
the automation system for which you want to perform the upgrade.  
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Note If you have selected the wrong automation system, you can move the license 
keys for the CPU 410 expansion packs by dragging and dropping. 

 

6. Open the "Online" folder in tree view for the automation system.  

7. Select the license and then select the "License Key > Upgrade" menu command. 

 

NOTICE When you initiate the upgrade, the selected CPU 410 expansion packs are 
assigned to the SEC. Moving to another AS is no longer possible. The SEC must 
not be changed between both CPUs (rack 0 and rack 1) until transferring the 
release file. 

 

 

 

The license keys for the selected CPU 410 expansion packs are deleted and an 
activation file is created in the folder: "Documents > Siemens > Automation > 
PCS 7 > Activations" 
("C:\Users\<USER>\Documents\Siemens\Automation\PCS 7\Activations"), with 
<USER> for your Windows username. 

The ALM displays which expansions are involved in the activation files. In this 
example of an activation file for a volume expansion from 600 to 700. 
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2.6.5 Sending the activation file via a Support Request 

The Activation File is now sent to the Technical Support via Support Request in 
order to receive a Release File: 

1. First start a Support Request via the website 
https://support.industry.siemens.com/cs/my/src?lc=en-WW. 
 

Abbildung 2-7 

 

 

2. Step "Search product": 

– Enter "CPU 410" in the entry field "Product/Order number" and click on the 
button "Find" (1). 

– Click on the "Next" button (2).

1

2

 
 

https://support.industry.siemens.com/cs/my/src?lc=en-WW
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3. In the register "Problem description", in the area "First help for the selected 
product", you will find contributions which can help you with your problem (1). 

4. Describe the problem. 

– Make the entries in the mandatory fields (2). 

– Enter the text "Request Release-File" in the entry field "Details of the 
Request" (3). 

– - Insert the activation file as a zip file by clicking or by dragging & dropping 
the activation file on the area "Move your files ("Drag and drop") into this 
field or click to select files" (4). 

– Click on the "Next" button (5). 

21 3

4

5

 

 
 

Note Activation files are automatically created in the following Upgrade directory in the 
Engineering Station:  
"Documents > Siemens > Automation > PCS7 > Activations" 
("C:\Users\\Documents\Siemens\Automation\PCS 7\Activations") stands for your 
Windows username 

 

Note You can send several activation files with one support request. 

 

5. "Specify contact data" step: Specify your contact data, then click on the "Next" 
button.  

6. "Summary and send" step: Check your details, then click on the "Send" button. 
Within 48 hours you will receive an e-mail containing a release file for each 
activation file sent.  
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2.6.6 Transferring the release file to the SEC of the CPU 

Requirements 

The CPU 410 must be accessible from the Engineering Station. The same PCS 7 
project (HW Config and program) must be loaded which was loaded when creating 
the activation file. The reason is while transferring the release file some names are 
compared e.g. project name, name of the automation system and CPU. 
The transferring of the release file must be carried out by the same user from the 
same ES as creating the activation file, since the upgrade directory is only created 
for this user. 

Procedure 

1. Transfer the received release files to the Upgrade directory in the Engineering 
Station: "Documents > Siemens > Automation > PCS 7 > Activations" 
("C:\Users\<USER>\Documents\Siemens\Automation\PCS 7\Activations"), with 
<USER> for your Windows username. 

2. Open the Automation License Manager (ALM). 
The automation systems that are connected to the Automation License 
Manager are shown in the list in the "Connect AS 410" dialog box. 

3. Click on the "Add" button to connect a further automation system. In the PCS 7 
project, select the CPU to which you want to transfer the release file. Then 
click on the "OK" button. 

 

 

The CPU is displayed in the ALM. 

4. Drag&drop the release file to the "Online" folder of the desired automation 
system. 

 

The upgrade is carried out. The time that is taken depends on the loading of the 
automation system. 
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After an upgrade is completed, the files (release file and activation file) that are 
used in the Upgrade directory are deleted. 

 

The Automation License Manager shows the new number of POs for the updated 
SEC as well as any PN Red license that may be available (in this example there is 
no PN Red). 

 

 

Note You can also call up the volume of the SEC, as well as the process objects that 
are subject to license, in the SIMATIC Manager under "Extras > PCS 7 license 
information".  

 

2.7 Further functions of the CPU 410 

2.7.1 Field Interface Security 

Field Interface Security is a function for additional protection of the automation 
system and which is supported from Firmware V8.2 upwards. It can be activated if 
a CPU interface is used only for the connection of field devices. 
Activating Field Interface Security blocks access to the CPU through the interface 
concerned by impeding build-up of a communication incoming from external nodes. 
This means that all queries are rejected and that only the communications outgoing 
from the CPU, e.g. for IO operation, continue to be permitted. 

Benefits 

• For protection against unauthorized access from the field bus 

• Separate activation for each interface 

• No restrictions of performance for field bus communication 

Configuration 

The Field Interface Security function is supported for the PROFINET as well as for 
the PROFIBUS interface and can be activated or deactivated in the HW Config in 
the settings of the interface via a check box. For the PROFINET interfaces, the 
checkbox "Enable additional protection on the interface (Field Interface Security)" 
is located in the PROFINET tab. 
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Fig. 2-8 

 

 

Note For further information on the protection of the automation system and the 
characteristics of the block (Field Interface Security) please refer to the manual: 
"SIMATIC PCS 7 Process Control System CPU 410 Process Automation" 
https://support.industry.siemens.com/cs/ww/en/view/109748473 

2.7.2 Security Event Logging 

Security Event Logging is a function to register user activity on a CPU. Security-
relevant changes to the CPU are sent as SysLogEvents to one or more SIEM 
(Security Incident Event Management) systems, where they are interpreted and 
processed further. When using the CPU 410 Security Event Logging is supported 
from Firmware V8.2 and newer. 

The following actions, for instance, are registered as SysLogEvents: 

• Connection setup with correct legitimation 

• Error in the legitimation (incorrect password) 

• A configuration change has been made 

• A PCS 7 user program change has been transmitted 

  

https://support.industry.siemens.com/cs/ww/en/view/109748473
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Benefits 

• Acquisition of safety-relevant changes on the CPU 

• Detection of forbidden access and deviations from normal behavior 

• Applicative assignment of user name by SIEM 

Configuration 

Further information on security event logging with SysLogEvents, including 
instructions for configuration and planning can be found in the application example: 
“Recording User Activity on a SIMATIC Controller Using a SIEM System” 
https://support.industry.siemens.com/cs/ww/en/view/109748211 

2.7.3 Remaining load memory 

From Firmware V8.2 the memory concept of the CPU 410 changes. With the new 
memory concept, the program is automatically stored in the remanent memory 
(FLASH) after every download and not in the battery-buffered RAM as before.  
This means that the program is preserved even in the absence of a buffer battery. 
This function is independent of the hardware version of the CPU, i.e. each CPU 
410-5H is already prepared for the remanent memory. 

It is to be noted that each CPU 410 which has already been used can contain a 
program that starts when the CPU is started. If the program does not start, the 
CPU must be reset to factory defaults. 

The new memory concept does not affect dynamic data, e.g. diagnostics buffers, 
counters, process images and current process values. These continue to be stored 
in a non-remanent manner and are retained as before only when a buffer battery is 
used across the network. 

If the current process values from selected blocks are to be transferred from the 
unbuffered memory to the remanent memory, this is possible with the "Read back 
program ..." function. 

Note If you begin to use a CPU that has already been used elsewhere, make sure that 
the content stored in the load memory does not cause dangerous system 
conditions at the new location. 

If the previous use of the CPU is unknown to you, reset it to its default settings. 

The CPU 410 can be reset to factory settings by pressing the reset button when 
the power supply is switched on and then held until the STOP LED flashes. 

2.7.4 Firmware update in two steps 

With CPU 410 firmware V8.2 and newer it is possible to update the firmware update 
in two working steps. This allows the firmware update of the CPU to be prepared in a 
first operating step (loaded into the CPU) during operation and to be activated in a 
later step in a second step. 
Especially in the case of H systems, a significantly faster firmware update with less 
time is achieved in solo operation, since the firmware can be loaded first into both 
CPUs and the H system can then operate exclusively to activate the firmware in solo 
operation. 

Benefits 

• A Firmware update can be prepared during normal operation 

• Optimized self-test after the Firmware update 

• Reduced overall time required for firmware updates 

https://support.industry.siemens.com/cs/ww/en/view/109748211


2 Application scenarios 

 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V3.2,    10/2019   79 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Procedure 

The firmware update in two steps can be started as until now via HW Config. In HW 
Config select the “Target system > Update firmware” menu command. 
A dialog for updating the firmware appears. In this dialog there are three options 
available from firmware V8.2 and upwards: 

(1) “Load and activate firmware” 

(2) “Load firmware only” 

(3) “Activate loaded firmware” 

When a firmware is loaded via option (2), the files for the firmware update are 
transferred to the CPU. The loaded firmware can then be activated with option (3), 
updating the CPU to the new firmware. 

Fig. 2-9 

1

2

3

 

Note For further information on updating firmware, please refer to the manual: 
"SIMATIC PCS 7 Process Control System CPU 410 Process Automation" 
https://support.industry.siemens.com/cs/ww/en/view/109748473 

https://support.industry.siemens.com/cs/ww/en/view/109748473
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2.8 Additional information 

2.8.1 Replacing an existing CPU with the CPU 410-5H  

An existing CPU in the S7-400 series can be replaced by the CPU 410-5H with little 
effort. In addition to the replacing the hardware, some adaptations must also be made 
to the hardware configuration of the PCS 7 project. You will find extensive information 
about this at https://support.industry.siemens.com/cs/ww/en/view/85014617. 

 

2.8.2 Extending availability 

With the standard SIMATIC PCS 7 AS 410 automation system, you already have the 
option of selectively increasing the availability by means of redundant configuration of 
the Industrial Ethernet communications module. 

With its redundant CPUs, the Type AS 410H redundancy station offers considerably 

greater availability. It works on the 1 -of-2 principle, where the reserve system is 

switched in if there is a failure of the active subsystem. Starting from here, you can 
double the power supply or the Industrial Ethernet communications module for each 
subsystem and combine these measures. 

You can find extensive information about the procedure for expanding a Single Station 
to a Redundancy Station at 
https://support.industry.siemens.com/cs/ww/en/view/82523363. 

 

https://support.industry.siemens.com/cs/ww/en/view/85014617
https://support.industry.siemens.com/cs/ww/en/view/82523363
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3 Appendix 

3.1 References 

 

Table 3-1 

 Topic area Title 

\1\ Siemens Industry Online 
Support 

http://support.industry.siemens.com 

\2\ Download page for this entry https://support.industry.siemens.com/cs/ww/en/
view/96839331 

\3\ SIMATIC PCS 7 Process Control 
System CPU 410 Process 
Automation 

https://support.industry.siemens.com/cs/ww/en/
view/109748473 

\4\ SIMATIC PCS 7 Service Support 
and Diagnostics (V9.0) 

https://support.industry.siemens.com/cs/ww/en/
view/109746550 

\5\ Security guidelines for 
PROFIBUS & PROFINET 
International (PI): 

http://www.profibus.com/nc/download/specificat
ions-standards/downloads/profinet-security-
guideline/display/ 

 

3.2 Change documentation 

 

Table 3-2  

Version Date Change  

V1.0 10/2014 First edition 

V1.1 12/2014 Revision of Chapter 2.2 Loading interface changes from AS 
blocks in RUN mode (TCiR)  

V1.2 03/2015 • New Chapter 2.1 Configuring the communications 
interface and 
Establishing the connection between the ES and the AS 

• Revision of Chapter 2.4 Configuring the PN/Ethernet 
interfaces of the CPU 410 

V1.3 02/2016 • New Chapter 2.3 Using TCiR to update a library 

• Revision of Chapter 2.2 Loading interface changes from 
AS blocks in RUN mode (TCiR) 

V2.0 03/2016 Update for PCS 7 V8.2 

V2.1 11/2016 Description for the PO expansion to “Unlimited" added 
(Section 2.5.1). 

V3.0 08/2017 Update for PCS 7 V9.0 

V3.1 09/2017 Chapter 2.6 directory path updated and notes added 

V3.2 10/2019 Chapter 2.6.5 Updated procedure 

 

http://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/96839331
https://support.industry.siemens.com/cs/ww/en/view/96839331
https://support.industry.siemens.com/cs/ww/en/view/109748473
https://support.industry.siemens.com/cs/ww/en/view/109748473
https://support.industry.siemens.com/cs/ww/en/view/109746550
https://support.industry.siemens.com/cs/ww/en/view/109746550
http://www.profibus.com/nc/download/specifications-standards/downloads/profinet-security-guideline/display/
http://www.profibus.com/nc/download/specifications-standards/downloads/profinet-security-guideline/display/
http://www.profibus.com/nc/download/specifications-standards/downloads/profinet-security-guideline/display/
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